
中華民國第 57屆中小學科學展覽會 

作品說明書 
 

 

國中組  化學科 
 

第三名 
 

030213-封面 

Oh！「葉」 ~利用手機光譜儀探討市售植物油

在可見光雷射照射下發光之行為 
   

學校名稱：彰化縣立陽明國民中學 

作者： 指導老師： 

國一 陳鈞彥 

國一 黄子祐 

國一 郭界宏 

 

許筑瑋 

韓顏吉 

 

關鍵詞：葉綠素、螢光、拉曼散射 



摘要 

本研究主要探討市售植物油受綠光及藍紫光照射後的發光行為。為了分析油品的發光情

形，使用簡易手機光譜儀並輔以 ImageJ 來解析發光的波譜分布。 

實驗發現綠光照射沙拉油及橄欖油皆會發出紅光，但前者是拉曼散射所致，而後者則是

螢光效應所致，兩者強弱不同；以藍紫光照射，沙拉油發出連續光譜，而橄欖油只發出紅光。

另外，葵花油、苦茶油、葡萄籽油受綠光及藍紫光照射後，分別發出波長較長的連續光譜，

此乃油品以壓榨法製作，保留天然成份所致。 

最後，將桑葉粉溶入沙拉油中，在藍紫光照射下隨濃度增加，會發出較強紅色螢光，並

在濃度較高時會有螢光自體吸收情形；而在綠光照射下，除了發出紅色螢光外，也同樣發出

波長較長的連續光譜。 

 

壹、研究動機 

之前曾經在蘋果日報上看到一則報導，是關於第 54 屆全國科展國小組化學科「安全油理

－市售橄欖油與各類油品特性檢驗」的研究，內容提到以綠光雷射筆照射橄欖油，橄欖油中

若含有微量的葉綠素，則會發出紅色的螢光，若非天然的橄欖油則會發出黃光，並利用此行

為來辨識橄欖油的真假，我們對於這樣的報導到非常有興趣，為何橄欖油在綠光雷射的照射

下會發出紅光?依照課堂上老師所教，葉綠素不是不容易吸收綠光嗎?再來，為何照射沙拉油

又會發出黃光，基於以上的種種疑問，本組將以此為科展主題，來解開植物油品發光的奧秘。 

   
圖 1 蘋果日報報導 圖 2 橄欖油發紅光 圖 3 假油發黃光 
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貳、研究目的 

一、確認桑葉粉溶液受綠光、藍紫光照射後，發出紅光之情形。 

二、探討不同濃度的桑葉粉丙酮溶液，受綠光、藍紫光雷射照射後，發光變化情形。 

三、探討沙拉油及橄欖油，受綠光、藍紫光雷射照射後，發光情形。 

四、探討市售沙拉油、橄欖油及自行配置沙拉油加桑葉粉溶液的吸收光譜變化情形。 

五、探討不同濃度桑葉粉沙拉油溶液對 665nm 波長的吸收情形。 

六、以自製手機光譜儀檢測油品發光行為。 

七、探討市售植物油品，受綠光、藍紫光雷射照射後，發光情形。 

 

參、研究設備及器材 

一、器材與藥品 

    

沙拉油 葡萄籽油 葵花油 桑葉粉 

    

比色槽(四面透光) 分光光度計 Nikon Coolpix P300 電子秤(0.01g) 

    

紅外線測溫槍 雷射筆 雷射護目鏡(防紫光) 雷射護目鏡(防綠光) 
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酒精 丙酮 黑色絕緣膠帶 樣品瓶 

   

 

紅光濾色片 方形玻璃容器 維義特級初榨橄欖油  

※ 綠光光源 532±10nm，藍紫光光源 405±10nm 操作時必須符合 CNS 11640 雷射安全使用

標準。須注意雷射筆操作場所之安全，使用時必須配戴相應之護目鏡。 

 

二、實驗裝置設計 

 

 

圖 4 實驗裝置示意圖。 
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手機光譜儀 

 

圖 6 儀器原理概念圖 

本研究所使用之手機光譜儀是由科學 Maker 社群所製作而成的，在本體設計上，重新根

據光學成像與繞射原理，規畫垂直式短光徑設計，可同時提升光強與解析度。在光柵的設計

上，使用特殊製作之高效率光柵，與新光路結合後不僅光效率提高為研究用等級，可以免除

一般自製儀器光譜彎曲的問題。 

圖 5 實驗裝置圖。 

雷射光源置於暗箱之

內，並以相機拍攝發光

情形，降低雷射造成危

害之可能風險。 

相機拍攝處 
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圖 7 SciView 手機光譜儀 圖 8 分光光度計模組中前端擴充 

 

圖 9 手機光譜儀 

3D 列印 

因為要偵測螢光與散射光，光源與其他部件不在一條直線 上，而是呈 90°直角，因此必

須重新設計光譜儀的前端模組，所以採用 3D 列印技術製作。使雷射光源能貼近側邊，並與

手機觀測方向呈 90°直角，同時也降低雷射所帶來的風險。 

 
圖 10 3D 列印機 

 

圖 11 線上設計網站 Tinkercad 
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圖 12 分子激發螢光過程之能

階變化圖。 

肆、研究過程與方法 

一、螢光發光的原理 

1、螢光原理 

大多數分子在室溫時均處在基態，當分子受某波長光線

（例如紫外線或ｘ射線）照射而吸收了特定能量，其電子可產

生躍遷至激發態。其後，大多數分子會和周圍的分子撞擊而消

耗了能量，而迅速落至第一電子激發態的最低振動能階。分子

在第一電子激發態的最低振動能階停留約10-9
 秒之後，會直接

下降至電子基態的各個不同振動能級，此時以光的形式釋放出

多餘的能量，所發生的光即是螢光。而釋放出另一較長波長的

光線（通常是可見光），即是我們所能見到的螢光。螢光物質

並非主動發光體，而是「光致發光」的現象，本身並不放出熱量，所以是一種冷發光。最強

和最有用的螢光被發現於其有低能量的π–π* 躍遷能階的芳香族官能基化合物，其次為含有脂

肪族及環脂肪族羰基結構或高度共軛雙鍵結構的化合物。 

以雷射為激發光源的靈敏度較高，因為雷射具有高強度，帶寬窄及同調性的特點，所以

其單位面積上的強大能量，能有效提高靈敏度。 

二、葉綠素螢光原理 

    葉綠素在電磁波光譜中的藍紫光波

段有最強的吸收，其次是紅光波段，然而

對綠光及鄰近波段的吸收很差，因此含葉

綠素的組織呈現綠色。 

    葉綠素的吸收光譜如下，分子吸收藍

光(430nm)或紅光(670nm)後，分別激發為

第二激發態或第二激發線態，或進一步轉

變為第一三線態，當他們進一步回到基態

時則產生螢光或磷光。  圖 13 葉綠素分子吸收光能後能量轉變。 
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綠葉產生螢光的主要成分 

 
圖 14 葉綠素 a 的吸收光譜與螢光光譜。 

由圖 14 可知：葉綠素 a 的吸收光譜大約在藍光及紅光波段，而根據文獻得知在葉綠體內

僅葉綠素 a 才有螢光光譜。且在紅光波段最大吸收波長與最大放出螢光波長有些許偏移，並

非完全重疊。 

 

三、沙拉油(soyebeam oil)及橄欖油(olive oil)之螢光性質 

由文獻得知，沙拉油及橄欖油在受到波長 425nm(藍光)的光照射下，其螢光性質如下圖所示。 

  

圖 15  Fluorescence spectroscopy of vegetable oils. 

取自：Quick Fluorescence Method for the Distinguishing of Vegetable Oils. 

橄欖油因富含有葉綠素 a，所發出螢光波長之峰值落在 679nm，而大豆沙拉油因不含葉

綠素 a 或者是含極少量的葉綠素 a，因此所發出之螢光波長無明顯峰值。 
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四、拉曼光譜 

拉曼光譜是根據拉曼散射（Raman scattering）

而衍生出來的光譜技術，於 1928 年被印度物理學

家拉曼（Chandrasekhara V. Raman）發現，這項發

現讓他於 1930 年獲得諾貝爾物理學獎。光與物

質交互作用後，會有反射、螢光與散射等現象，

其中散射光的波長與入射光的能量或波長不同稱

為「拉曼散射」。由於拉曼散射的訊號遠小於螢

光，因此需要高強度的入射光與高靈敏度的光偵

測器才能偵測到訊號，所以在初期並沒有被廣泛

地應用，1953 年才有第一套商業化的拉曼光譜儀

問世，但是訊號依然十分的微弱。直到 1960 年雷

射的發明，並且被用來當作拉曼光譜的光源，解

決了入射光強度不足的問題，才改善了拉曼光譜

的研究與應用。 

 

圖 16 拉曼散射示意圖。 

 
圖 17 拉曼散射能階示意圖。 

五、螢光強度量測方法 

本組使用電腦軟體 ImagJ 進行螢光強度定量分析。 

 

首先開啟要分析之照片選取 File → Open 

 
選取分析區域，接著按 Analyze → Historgam 
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將照片解析成 red、green、blue 三種結果。 

  

讀取 Mean 之值，為選取範圍各色光平均強度，數值越大代表越亮。 

由上範例紅光 27.8，綠光 137.1，藍光 12.6。 
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伍、研究結果與討論 

一、確認桑葉粉溶液受綠光、藍紫光照射後，發出紅光之情形。 

依據新聞報導，橄欖油被綠光雷射筆照射後會發出紅色螢光，宣稱因為橄欖油中富含豐

富的葉綠素，葉綠素吸收綠光後，會發出紅色的螢光，但是在課堂上學到葉綠素是不易吸收

綠光的，那為何會發出紅色螢光，我們對此感到好奇，因此設計以下實驗。 

本組將桑葉粉溶在四種不同的溶劑中(水、丙酮、酒精、沙拉油)，並分別以綠光及藍紫

光雷射照射，拍攝其發光情形。 

  

圖 18 新聞報導 圖 19 四種不同桑葉粉溶液 

藍 

紫 

光 

    
水 酒精 丙酮 沙拉油 

綠 
光 

    
水 酒精 丙酮 沙拉油 

說明：由實驗結果可以明顯看到桑葉粉溶在酒精、丙酮及沙拉油中，經藍紫光照射會發出紅

光且無法穿透，而以水泡成的桑葉粉溶液就無法發出紅光。另外，若以綠光雷射照射的話，
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酒精、丙酮、沙拉油三種溶劑，則觀察到紅、黃、綠等混合色光。 

經查資料後發現：葉綠素屬於鎂卟啉衍生物，是一種雙羧酸酯，不溶於水，易溶於乙醇、

丙酮、乙醚等有機溶劑，故水溶液中幾乎沒有葉綠素，就無法發出紅光，故雷射筆照射後所

看到的光均為反射光與散射光。 

由上面兩張 

二、探討不同濃度的桑葉粉丙酮溶液，受綠光、藍紫光雷射照射後，發光變化情形。 

為了瞭解葉綠素受綠光及藍紫光照射後發情形，本組以丙酮為溶劑，加入不同質量的桑

葉粉，靜置 24hr 後過濾，配置成不同濃度的桑葉粉丙酮溶液，並透過紅光濾色片觀察葉綠素

的濃度對其發光行為之影響。 

表格說明 

以丙酮為溶劑 

綠光光源，無紅光濾色片  

    
0g/40ml 0.0046875g/40ml 0.009375g/40ml 0.01875g/40ml 

3.3 21 3.3 22 67 12 27 80 14 34 73 16 

    
0.0375g/40ml 0.3g/40ml 0.6g/40ml 0.9g/40ml 

42 92 18 76 149 31.2 56 126 27 39 75 17 

    
1.2g/40ml 1.5g/40ml 1.8g/40ml 2.1g/40ml 

34 61 15 35 62 16 36 47 16 13 14 16 

3.3 21 3.3 

紅光強度 
綠光強度 

藍光強度 
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由實驗結果得知，隨著桑葉粉濃度增加，可以看出綠光的光徑逐漸縮短，說明葉綠素有吸收

綠光的能力。 

 

圖 20 不同濃度葉綠素丙酮溶液受綠光雷射照射後，發光強度變化情形。(無紅光濾色片) 

由圖 20 發現在低濃度時，由側面觀察到的光線主要是由散射所造成的，所以隨著濃度增

加綠光散射強度越強，但是在較高濃度時，綠光強度反而降低，且光徑縮短，代表綠光有被

吸收的情形發生。 

綠光光源，有紅光濾色片 

    
0g/40ml 0.0046875g/40ml 0.009375g/40ml 0.01875g/40ml 

5.7 3.3 6.8 14 4 10 23 6 14 35 8 17 

    
0.0375g/40ml 0.3g/40ml 0.6g/40ml 0.9g/40ml 

38 10 26 196 45 70 109 21 43 86 17 33 

    
1.2g/40ml 1.5g/40ml 1.8g/40ml 2.1g/40ml 

71 14 29 62 13 26 48 9 20 14 5 10 

低濃度 
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由實驗結果可知，透過紅光濾色片觀察發光情形，發現在完全無葉綠素的情況下，結果

是一片漆黑的，但是若含有葉綠素後就可以明顯偵測出紅光，且光徑逐漸縮短，因此可以證

明葉綠素確實會吸收綠光後，且放出紅光之情形。 

 
圖 21 不同濃度葉綠素丙酮溶液受綠光雷射照射後，發光強度變化情形。(有紅光濾色片) 

由結果來看在低濃度區域時，紅光強度會隨葉綠素濃度增加而增強，但當濃度過高時，

放出的紅光反而越弱，這與我們早先的預期不同，經由查照文獻得知，螢光分子濃度愈高，

遇光被激發的分子數愈多，螢光強度照理來說會變強，但是濃度太高的時候，會有「自我吸

收」的狀況，也就是因為分子間距離較近，分子受激發所放出的光會被其周圍的螢光分子所

吸收，因而降低螢光強度，而葉綠素此種螢光自我吸收現象非常嚴重，因為其吸收光譜及螢

光光譜在紅光的波段有很大的重疊。 

藍紫光光源，無紅光濾色片 

    
0g/40ml 0.0046875g/40ml 0.009375g/40ml 0.01875g/40ml 

0 71 194 134 41 176 164 59 175 180 62 153 

    
0.0375g/40ml 0.3g/40ml 0.6g/40ml 0.9g/40ml 

204 73 145 139 40 67 72 20 36 46 16 25 

低濃度 
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1.2g/40ml 1.5g/40ml 1.8g/40ml 2.1g/40ml 

44 14 26 45 15 29 27 17 19 21 8 15 

由結果得知，隨著葉綠素濃度增加，可以看出紫光逐漸被吸收，且發出紅光。 

 
圖 22 不同濃度葉綠素丙酮溶液受藍紫光雷射照射後，發光強度變化情形。(無紅光濾色片) 

由圖 22 來看，隨著葉綠素濃度增加，藍紫光的強度逐漸減弱，而發紅光情形則是在低濃

度時隨濃度增加而增強，在高濃度時則發生螢光自體吸收現象。 

藍紫光光源，有紅光濾色片 

    
0g/40ml 0.0046875g/40ml 0.009375g/40ml 0.01875g/40ml 

8.0 4.0 11.4 154 31 73 186 47 85 200 58 90 

    
0.0375g/40ml 0.3g/40ml 0.6g/40ml 0.9g/40ml 

225 81 111 141 27 51 71 17 31 50 11 23 

低濃度 
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1.2g/40ml 1.5g/40ml 1.8g/40ml 2.1g/40ml 

38 9 19 38 10 19 34 7 17 15 5 10 

 

 
圖 23 不同濃度葉綠素丙酮溶液受藍紫光雷射照射後，發光強度變化情形。(紅光濾色片)。 

透過紅光濾色片觀察不同濃度葉綠素丙酮溶液受藍紫光雷射照射後，發光情形，由結果

來看在低濃度時發紅光強度與葉綠素濃度呈正相關，而濃度太高時有螢光自體吸收現象的發

生。 

 

三、探討沙拉油及橄欖油，受綠光、藍紫光雷射照射後，發光情形。 

為了釐清沙拉油及橄欖油發光的行為，本組嘗試許多樣品，來探討此兩種油品受到綠光、藍

紫光雷射照射後，發出紅光的原因。 

 (1) 沙拉油 

    

仔細觀察可以看到

紅、綠混合的光徑。 

較細的紅色光徑。 產生偏白光且較粗的

光徑。 

較粗的紅色光徑。 

低濃度 
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說明： 

沙拉油在綠光及藍紫光雷射照射下，透過紅光濾色片觀察發現，竟然可以看到穿透容器

的紅光，這與之前報導是有出入的，沙拉油不含葉綠素，照理來說沒有螢光的效應，不應該

觀察到紅光。為了釐清此以現象，本組首先以清水測試，確認紅光濾色片沒有問題。 

(2) 清水 

    

細小的綠色光徑 全黑，無紅光 細小的藍紫色光徑 全黑，無紅光 

說明： 

由實驗結果來看，完全沒有觀察到紅光，所以紅光濾色片沒有問題。在清水實驗中所產

生的光徑比較細小，而在沙拉油實驗中在紫光照射下會產生較粗的光徑，本組懷疑是否有所

謂的廷德耳效應，也就是紫光受到沙拉油分子散射，所以才能在垂直入射光方向觀察到散射

後的光線，而照射清水不會產生散射，所以為了釐清是否是散射才產生紅光，因此本組將少

許牛奶加入清水中，使其變為膠體溶液，來產生大量的散射，觀察是否有紅光的發生。 

(3) 清水+牛奶 

 

    

產生強烈的散射 全黑，無紅光 產生強烈的散射 看到紫光，但無紅光 

說明： 

確實產生非常強烈的散射，但還是完全觀察不到紅光的發生，即便是紅光濾色片無法濾
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掉所有紫光，還是無紅光產生。正常來講，沙拉油是不含葉綠素的，因此不應該會看到紅光，

因此本組懷疑紅光是來自於沙拉油本身，而不是葉綠素本身發螢光，所以改用高溫加熱過後

的高溫沙拉油進行實驗，藉由高溫加熱來排除葉綠素影響的可能性。 

 

 (4) 高溫沙拉油 

以電磁爐加熱沙拉油，溫度達發煙點以上，並以紅外線溫度計測量其溫度，約為 250℃。排

除葉綠素存在的可能性。 

    

仔細觀察可以看到

紅、綠混合的光徑。 
較細的紅色光徑。 產生偏白光且較粗的

光徑。 
較粗的紅色光徑。 

說明： 

由實驗結果來看，綠光照射高溫沙拉油會產生紅、綠混合的光徑，且經由濾色片觀察明

顯發出紅光。而以藍紫光照射高溫沙拉油則會產生偏白光且較粗的光徑，穿透整個容器，且

透過紅光濾色片觀察，確實是發出紅光，意謂著沙拉油會散射出紅光，但不易吸收藍紫光。 

那沙拉油在綠光及藍紫光照射下為何可以檢測到紅光呢?本組經由前面一系列的反覆驗

證及文獻查找，認為這種現象可能是所謂的拉曼散射。 

拉曼散射的原理是入射光與物質交互作用後會產生散射，散射可以分為兩種，第一種是

彈性碰撞，也就是散射光與入射光的能量或波長相同，此種散射稱為「雷立散射（Rayleigh 

scattering）」。第二種為非彈性碰撞，也就是散射光與入射光的能量或波長不同，散射光會

獲得或者是損失物質所貢獻的能量，其中獲得能量稱為「反斯托克散射（Anti-stoke scattering）」，

損失能量則稱為「斯托克散射（Stoke scattering）」，拉曼散射即為此第二種散射原理。 

拉曼散射的能量或波長改變與入射光的波長無關，這個能量的改變反映出物質或者是分

子的振動頻率。其中同樣的分子結構，根據排列的不同會有不同的振動頻率，也代表有不同

的「拉曼位移（Raman shift）」，藉由透過拉曼散射所造成的能量不同去辨別分子結構的不

同，因此能分辨重金屬、農藥殘留的種類。 
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(5) 橄欖油 

維義特級初榨橄欖油 500ml，經衛服部認證為合格的橄欖油，未添加銅葉綠素。 

    

偏紅色的細小光徑 紅色的較大光徑 明亮紅光 明亮紅光 

說明： 

由實驗結果可以看出橄欖油在綠光及藍紫光照射下，可以明顯看到發出紅色光徑，且藍紫光

的光徑有縮短，代表葉綠素較易吸收藍紫光。 

 (6) 0.3g 桑葉粉+40ml 沙拉油 

將桑葉粉加入沙拉油中，再次確認葉綠素確實會使油品發出紅色螢光。 

    

白色粗大光徑 紅色粗大光徑 縮短紅色光徑 縮短紅色光徑 

由結果來看，加了桑葉粉的沙拉油，其發光行為與與橄欖油接近，但是受綠光照射其光徑有

變粗的情形。 

(7) 橄欖油+鹽酸 

由文獻得知葉綠素易受到高溫、酸及鹼的破壞，因此本組將濃鹽酸加入橄

欖油中，靜置 4 小時，結果溶液分為兩層，下層為鮮艷綠素的濃鹽酸，上

層油脂呈些許混濁狀態，有細小懸浮微粒。本組取上層油脂部分進行實驗。 
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強烈的散射 超弱的紅光 一點白光 微弱的紅光 

說明： 

由實驗結果來看，確實紅光變弱了，這是因為氫離子取代了葉綠素中的鎂離子，使得葉

綠素螢光效應減弱。 

綜合以上一連串的實驗，本組認為橄欖油照射可見光雷射後，其發光行為與其所含之葉

綠素有關，而沙拉油的發光行為則是所謂的拉曼散射，因此可以利用其發光特性差異來判斷

油品中是否含有葉綠素。 

 

四、探討市售沙拉油、橄欖油及自行配置沙拉油加桑葉粉溶液的吸收光譜變化情形。 

為了瞭解沙拉油、橄欖油及添加桑葉粉的沙拉油對可見光的吸收情形，本組以分光光度

計(科展獎金補助購置的)量測樣品的吸收光譜。 

 

圖 24 沙拉油、橄欖油及添加桑葉粉的沙拉油對可見光吸收情形。 

由圖 24 可以看出沙拉油在紫光區的吸收度較高，但隨著波長增加，吸收度急遽降低，而

橄欖油及添加桑葉粉的沙拉油溶液有相似的吸收行為，除了在短波長有較高的吸收度外，在

波長 665nm 會有凸起的吸收峰。 

19



五、探討不同濃度桑葉粉沙拉油溶液對 665nm 波長的吸收情形。 

將 0.01g、0.1g、0.2、0.3g、0.4g、0.5g、0.6g、0.7g、0.8g、0.9g、1.0g 的桑葉粉分別加

入 20ml 沙拉油中，均勻混合，在靜置 24hr 後，將殘渣過濾出來，配置成不同濃度的桑葉粉

沙拉油溶液，並測量其對 665nm 波長的吸收度。 

 

圖 25 不同濃度的桑葉粉溶液 

 

 

圖 26 不同濃度桑葉粉沙拉油溶液對 665nm 的光吸收度變化情形。 

由圖 26 可以得知隨著濃度增加，對 665nm 波長的光吸收度會增加，並且逐漸趨緩。今

以橄欖油對 665nm 波長的吸光度(0.295)加以換算大約為 0.043g/20ml 的桑葉粉沙拉油溶液。 

 

 

0.01g 0.5g 

0.6g 1.0 g 
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六、以自製手機光譜儀檢測油品發光行為 

以電腦螢幕發光光譜為例 

設定分析線寬 

 

 

 

 

 

 

                                 可以得知可色光的強度變化情形 

 

 

 

Analyze→Plot Profile 

21



0.01g+20ml 沙拉油 (光源由側面照射) 

利用已知波長之光進行定位 

    

      

圖 27  0.01g/20ml 桑葉粉沙拉油溶液受綠光及藍紫光照射之發光光譜 

532 − 405

1900 − 1369
=

𝑥1 − 405

2472 − 1369
=

𝑥2 − 532

2472 − 1900
，𝑥 =

𝑥1 + 𝑥2
2

= 668.8 

 

(一) 不同濃度桑葉粉沙拉油溶液受藍紫光照射後的發光情形。 

    
20ml 沙拉油 0.01 g+20ml 沙拉油 0.1g+20ml 沙拉油 0.2g+20ml 沙拉油 

    
0.3g+20ml 沙拉油 0.4g+20ml 沙拉油 0.5g+20ml 沙拉油 0.6g+20ml 沙拉油 

    
0.7g+20ml 沙拉油 0.8g+20ml 沙拉油 0.9g+20ml 沙拉油 1.0g+20ml 沙拉油 

 位置(pixel) 波長(nm) 

藍紫光 1369 405 

綠光 1900 532 

紅光 2472 x 

405nm 

532nm 

推算 669nm 

藍紫光 綠光 

22



 

圖 28 不同濃度桑葉粉沙拉油溶液受藍紫光照射下，發光情形。 

說明： 

(1) 在未添加桑葉粉或桑葉粉濃度極低(0.01g/20ml)的情況下，以藍紫光照射，所觀察到的光

譜是偏向連續光譜，因此前項實驗以藍紫光雷射筆照射沙拉油觀察到散射白光是合理

的。 

(2) 隨著桑葉粉濃度增加，原本散射出來在 475nm 附近的波段易被葉綠素吸收，其發光光譜

就逐漸轉變成不連續光譜，且藍紫光也一併被吸收而發出紅光，如果濃度更高(>0.7g/20ml)

時，可以觀察到明顯的螢光自體吸收現象。 

(3) 紅光波段 隨濃度變化發光情形： 

 

由文獻得知葉綠素的發出螢光波長與其紅光最大吸收波長並不一致，因此發生螢光自體吸收

時，紅光波段的光譜才有凹陷變暗的情形 

 

 

405nm 

669nm 

475nm 

螢光自體吸收 
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(二) 不同濃度桑葉粉沙拉油溶液受綠光照射後的發光情形。 

    
20ml 沙拉油 0.01 g+20ml 沙拉油 0.1g+20ml 沙拉油 0.2g+20ml 沙拉油 

    
0.3g+20ml 沙拉油 0.4g+20ml 沙拉油 0.5g+20ml 沙拉油 0.6g+20ml 沙拉油 

    
0.7g+20ml 沙拉油 0.8g+20ml 沙拉油 0.9g+20ml 沙拉油 1.0g+20ml 沙拉油 

 

 

圖 29 不同濃度桑葉粉沙拉油溶液受綠光照射下，發光情形。 

不同濃度桑葉粉沙拉油受綠光照射，隨著桑葉粉濃度提高，而發出黃光波段的光，形成綠

光到紅光的連續光譜。本組認為其所發出黃光是由桑葉粉中其他物質的拉曼散射所造成的，

而且散射的波段落在 583nm 附近，不易被葉綠素吸收所致。 

 

 

 

 

 

532nm 532nm 

669nm 669nm 

583nm 

黃光區 

螢光自體吸收 
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改以不同溶劑溶解桑葉粉，觀察受綠光及藍紫光雷射後，發光之情形。 

溶劑 綠光 藍紫光 

水 

  

受綠光照射，無其它波長之散射光，而以藍紫光照射則散射出波長較小的光。 

丙酮 

  

很明顯可以看到發出紅光，即使以綠光照射也會發出紅光，再次驗證綠光會被葉綠素吸收

再放出紅光，且無連續光譜情形發生。 
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七、探討市售植物油品，受綠光、藍紫光雷射照射後，發光情形。 

 
橄欖油 

    

偏紅色的細小光徑 紅色的較大光徑 明亮紅光 明亮紅光 

  

橄欖油受綠光及藍紫光確實能發出較強烈的紅光，這是由葉綠素發螢光所造成的。 

葵花油 

    
細小光徑 細小紅色光徑 粗大白色光徑 粗大大紅色光徑 
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苦茶油 

    
中等光徑 粗大紅色光徑 縮短明亮光徑 縮短紅色明亮光徑 

  
葡萄籽油 

    
細小光徑 細小紅色光徑 粗大白色光徑 粗大大紅色光徑 

  
葵花油、苦茶油、葡萄籽油受綠光及藍紫光照射後，分別發出頻率較低，波長較長的連

續光譜，本組認為此類油品在製作時是以壓榨法製成，因此保存較多的天然成分，因此發出

連續光譜。 

而大豆沙拉油是採用浸提法製成，利用化學溶劑提取，並蒸餾分離，因此沙拉油受綠光

照射只單純發出紅光(拉曼散射)，橄欖油則是因為含有豐富的葉綠素所以在綠光及藍紫光照射

下都發出強烈的紅色螢光(螢光效應)。 
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陸、結論 

一、確認桑葉粉溶液受綠光、藍紫光照射後，發出紅光之情形。 

桑葉粉溶在酒精、丙酮及沙拉油中，經藍紫光照射會發出紅光且無法穿透，而以水泡成的

桑葉粉溶液就無法發出紅光。另外，若以綠光雷射照射的話，酒精、丙酮、沙拉油三種溶劑，

則觀察到紅、黃、綠等混合色光。這是因為桑葉粉中的葉綠素溶解後，吸收綠光及藍紫光所

致。 

二、探討不同濃度的桑葉粉丙酮溶液，受綠光、藍紫光雷射照射後，發光變化情形。 

1、在低濃度的情況下，受綠光、藍紫光雷射照射後，所發紅光與濃度是呈正相關，濃度越高

所發螢光越強。 

2、在高濃度的情況下，桑葉粉丙酮溶液受到自我吸收的影響，濃度越高所發螢光越少。 

三、探討沙拉油及橄欖油，受綠光、藍紫光雷射照射後，發光情形。 

1、橄欖油因富含葉綠素，因此受到綠光、藍紫光雷射照射後，其發光行為屬於螢光效應。 

2、沙拉油在受到綠光、藍紫光雷射照射後，利用紅光濾色片觀察其發光情形，可以明顯看到

紅光，但其發光行為屬於拉曼散射。 

四、探討市售沙拉油、橄欖油及自行配置沙拉油加桑葉粉溶液的吸收光譜變化情形。 

沙拉油在紫光區的吸收度較高，但隨著波長增加，吸收度急遽降低，而橄欖油及添加桑

葉粉的沙拉油溶液有相似的吸收行為，除了在短波長有較高的吸收度外，在波長 665nm 會有

凸起的吸收峰。 

五、探討不同濃度桑葉粉沙拉油溶液對 665nm 波長的吸收情形。 

隨著桑葉粉濃度增加，對 665nm 波長的光吸收度會增加，並且逐漸趨緩。今以橄欖油對

665nm 的吸光度(0.295)加以換算大約等同於 0.043g/20ml 的桑葉粉沙拉油溶液。 

六、以自製手機光譜儀檢測油品發光行為 

(一) 不同濃度桑葉粉沙拉油溶液受藍紫光照射後的發光情形。 

(1) 在未添加桑葉粉或桑葉粉濃度極低(0.01g/20ml)的情況下，以藍紫光照射，所觀察到的光

譜是偏向連續光譜，因此以藍紫光雷射筆照射沙拉油可觀察到散射白光。 

(2) 隨著桑葉粉濃度增加，原本散射出來在 475nm 附近的波段易被葉綠素吸收，其發光光譜
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就逐漸轉變成不連續光譜，且藍紫光也一併被吸收而發出紅光，如果濃度更高(>0.7g/20ml)

時，可以觀察到明顯的螢光自體吸收現象。 

(二) 不同濃度桑葉粉沙拉油溶液受綠光照射後的發光情形。 

不同濃度桑葉粉沙拉油受綠光照射，隨著桑葉粉濃度提高，而發出黃光波段的光，形成

綠光到紅光的連續光譜。本組認為其所發出黃光是由桑葉粉中其它物質溶入油中，導致拉曼

散射所造成的，而且散射的波段落在 583nm 附近，不易被葉綠素吸收所致。 

七、探討市售植物油品，受綠光、藍紫光雷射照射後，發光情形。 

葵花油、苦茶油、葡萄籽油受綠光及藍紫光照射後，分別發出頻率較低，波長較長的連

續光譜，本組認為此類油品在製作時是以壓榨法製成，因此保存較多的天然成分，因此發出

連續光譜。 

而大豆沙拉油是採用浸提法製成，利用化學溶劑提取，並蒸餾分離，因此沙拉油受綠光

照射只單純發出紅光，橄欖油則是因為含有豐富的葉綠素所以在綠光及藍紫光照射下都發出

強烈的紅色螢光。 
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作品海報 

【評語】030213  

優點： 

1. 主題清楚且聚焦，對於葉綠素在不同溶劑與油品中的發光行

為有完整的描述。 

2. 自製的觀測儀器值得鼓勵。 

3. 實驗紀錄詳盡及數據分析完整。 

建議： 

1. 作品構思具有創意，同時設計亦結合行動科技更貼近日常生

活值得嘉許，如果可以自製標準品校正每次實驗結果將可使

作品具有客觀性。 

2. 建議可使用不同部位之植物組織進行觀測，並對其中所對應

之葉綠素含量進行分析及觀測，如此一來可對其葉綠素含量

對應其光譜現象進行深入探討並使作品內容更加豐富。 

3. 市面上出售的油品都有添加其他成分，有的甚至是調和油。

建議須留意其影響。 

 



新聞報導，以綠光雷射筆照射橄欖油，宣稱橄欖油中因含有葉綠素，會發出紅色的螢光，

而非天然的橄欖油則會發出黃光，可利用此行為來辨識橄欖油的真假，本組感到好奇的是，

為何橄欖油在綠光雷射的照射下會發出紅光?依照課堂上老師所教，葉綠素不是不容易吸收

綠光嗎?再來，為何照射假橄欖油又會發出黃光，基於以上的種種疑問，本組將以此為目標，

來解開植物油品發光的奧秘。 圖1 新聞報導

參、研究設備

沙拉油 分光光度計橄欖油 桑葉粉

玻璃容器 濾色片

紅外線測溫槍

護目鏡 雷射筆

實驗裝置設計

實驗裝器材一、確認桑葉粉溶液受綠光、藍紫光照射後，

發出紅光之情形。

二、探討不同濃度的桑葉粉丙酮溶液，受綠

光、藍紫光雷射照射後，發光變化情形。

三、探討沙拉油及橄欖油，受綠光、藍紫光

雷射照射後，發光情形。

四、以自製手機光譜儀檢測油品發光行為。

五、探討市售植物油品，受綠光、藍紫光雷

射照射後，發光情形。

貳、研究目的

3D列印

肆、研究原理與方法

伍、研究結果與討論

藍
紫
光

綠
光

水 水酒精 酒精丙酮 丙酮沙拉油 沙拉油

說明：由實驗結果可以明顯看到桑葉粉泡在酒精、丙酮及沙拉油中，經藍紫光及綠光照射會發出紅色的螢光，而以水泡成的桑

葉粉溶液就無法發出紅色螢光。

水

一、確認桑葉粉溶液受綠光、藍紫光照射後，發出紅光之情形。

壹、研究動機

3D列印軟體

雷射光源置於暗箱之內，並

以相機拍攝發光情形，降低

雷射造成危害之可能風險。

相機拍攝處

手機光譜儀

分光光度計模組中前端擴充

光度計設計原理

SciView手機光譜儀

拉曼散射（Raman scattering），一種光子的非彈性散射現

象，1928年由印度物理學家錢德拉塞卡拉·拉曼發現，指光波

在被散射後頻率發生變化的現象。

當光線從一個原子或分子散射出來時，絕大多數的光子，

都是彈性散射的，這稱為瑞立散射。在瑞立散射下，散射出

來的光子，跟射入時的光子，它的能量、頻率與波長是相同

拉曼光譜

拉曼散射示意圖 拉曼散射能階示意圖

的。然而，有一小部份散射的光子（大約是一千萬個光子中會出現一個），散射後的頻率會產生變化，通常是低於射入時的光

子頻率，原因是入射光子和介質分子之間發生能量交換。這即是拉曼散射。

手機螢光光譜分析

ImageJ軟體

1.設定線寬

2.設定線寬 4.波長定位

3.強度分佈

藍紫光

綠光

405nm

532nm

推算669nm

0.01g/20ml桑葉粉沙拉油溶液受
綠光及藍紫光照射之發光光譜



二、探討不同濃度的桑葉粉丙酮溶液，受綠光、藍紫光雷射照射後，發光變化情形。

綠光光源，無紅光濾色片

綠光光源，有紅光濾色片

藍紫光光源，無紅光濾色片

藍紫光光源，有紅光濾色片

三、探討沙拉油及橄欖油，受綠光、藍紫光雷射照射後，發光情形。

(1) 沙拉油： (2) 清水：

紅、綠混合的光徑 偏白光且較粗的光徑 較細的紅色光徑 較粗的紅色光徑 細小的綠色光徑 細小的藍紫色光徑 全黑，無紅光 全黑，無紅光

(3) 清水+牛奶：

強烈的散射 強烈的散射 全黑，無紅光 看到紫光，無紅光

(4) 高溫沙拉油：

(5) 橄欖油： (6) 橄欖油+鹽酸：

四、以自製手機光譜儀檢測油品發光行為

(一) 不同濃度桑葉粉沙拉油溶液受藍紫光照射後的發光情形。

0g/40ml 0.0047g/40ml 0.0094g/40ml 0.019g/40ml 0.038g/40ml 0.3g/40ml

0.6g/40ml 0.9g/40ml 1.2g/40ml 1.5g/40ml 1.8g/40ml 2.1g/40ml

低濃度

低濃度

低濃度

低濃度

說明：

1、桑葉粉丙酮溶液受到綠光及紫光照射確實會發出不同波長(紅光)的光，代表桑葉粉溶入丙酮中的物質(葉綠素)會吸收綠光及紫光而發螢光。

2、在低濃度區發光強度與濃度成正比，但是在高濃度區會有「自體吸收」之行為。

綜合以上一連串的實驗，本組認為橄欖油照射可見光雷射後，其發光行為與其所含之葉綠素有關，而沙拉油的發光行為則是所謂的拉曼散射，因此

可以利用其發光特性差異來判斷油品中是否含有葉綠素。

圖28 不同濃度桑葉粉沙拉油溶液受藍紫光照射下，
發光情形。

說明：

(1) 在未添加桑葉粉或桑葉粉濃

度極低(0.01g/20ml)的情況下，

以藍紫光照射，所觀察到的光

譜是偏向連續光譜，因此前項

實驗以藍紫光雷射筆照射沙拉

油觀察到散射白光是合理的。

(2) 隨著桑葉粉濃度增加，原本散射出來在475nm附近的波段易被葉綠素吸收，其發

光光譜就逐漸轉變成不連續光譜，且藍紫光也一併被吸收而發出紅光，如果濃度

更高(>0.7g/20ml)時，可以觀察到明顯的螢光自體吸收現象。

405nm

475nm 669nm

0g 0.01g 0.1g 0.2g

0.3g 0.4g 0.5g 0.6g

0.7g 0.8g 0.9g 1.0g

濃度：桑葉粉質量/20ml沙拉油

拉曼散射
螢光效應
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陸、結論

一、探討不同濃度的桑葉粉丙酮溶液，受綠光、藍紫光雷射照射後，發光變化情形。

1、在低濃度的情況下，受綠光、藍紫光雷射照射後，所發紅光與濃度是呈正相關，濃度越高所發螢光越強。

2、在高濃度的情況下，桑葉粉丙酮溶液受到自我吸收的影響，濃度越高所發螢光越少。

二、探討沙拉油及橄欖油，受綠光、藍紫光雷射照射後，發光情形。

1、橄欖油因富含葉綠素，因此受到綠光、藍紫光雷射照射後，其發光行為屬於螢光效應。

2、沙拉油受到綠光、藍紫光雷射照射後，利用紅光濾色片觀察其發光情形，可以明顯看到紅光，但其發光行為屬於拉曼散射。

三、以自製手機光譜儀檢測油品發光行為

(一) 不同濃度桑葉粉沙拉油溶液受藍紫光照射後的發光情形。

(1) 在未添加桑葉粉或桑葉粉濃度極低(0.01g/20ml)的情況下，以藍紫光照射，所觀察到的光譜是偏向連續光譜，因此以藍紫光

雷射筆照射沙拉油可觀察到散射白光。

(2) 隨著桑葉粉濃度增加，原本散射出來在475nm附近的波段易被葉綠素吸收，其發光光譜就逐漸轉變成不連續光譜，且藍紫

光也一併被吸收而發出紅光，如果濃度更高(>0.7g/20ml)時，可以觀察到明顯的螢光自體吸收現象。

(二) 不同濃度桑葉粉沙拉油溶液受綠光照射後的發光情形。

不同濃度桑葉粉沙拉油受綠光照射，隨著桑葉粉濃度提高，而發出黃光波段的光，形成綠光到紅光的連續光譜。本組認

為其所發出黃光是由桑葉粉中其它物質溶入油中，導致拉曼散射所造成的，而且散射的波段落在583nm附近，不易被葉綠素

吸收所致。

四、探討市售植物油品，受綠光、藍紫光雷射照射後，發光情形。

以藍紫光及綠光雷射筆來檢疫橄欖油的真假是可行的，若輔以簡易手機光譜儀更能清楚油品的受激或散射的發光情形。

橄欖油含有葉綠素受雷射照射後會產生單一波長的光譜，而其他油品則產生連續的光譜，若直接觀察，橄欖油會發紅光，其

他油品受綠光照射會發出黃色的混合光，受藍紫光照射則發混合光。未來可運用此類新興檢驗方法提供科學數據；並秉持科

學論證基礎，持續開發新興檢驗方法，以因應食品管理所需，戮力把關國人飲食安全。

五、探討市售植物油品，受綠光、藍紫光雷射照射後，發光情形。

(二) 不同濃度桑葉粉沙拉油溶液受綠光照射後的發光情形。

圖不同濃度桑葉粉沙拉油溶液受綠光照射下，發光情形。

不同濃度桑葉粉沙拉油受綠光照射，隨著桑葉粉濃度提高，而發出黃光波段的光，形成綠光到紅光的連續光譜。本組認為

其所發出黃光是由桑葉粉中非葉綠素物質溶入沙拉油中的拉曼散射所造成的，而且散射的波段落在583nm附近，不易被葉綠素

吸收所致。

532nm 532nm

583nm
黃光區

螢光自
體吸收

橄
欖
油

葵
花
油

苦
茶
油

葡
萄
籽
油

橄欖油因含有葉綠素，因此

照射藍紫光及綠光雷射後，會發

出紅色螢光，且可經由簡易的手

機光譜儀，測量其發光光譜，為

不連續光譜。而苦茶油、葡萄籽

油、苦茶油因含有極少的葉綠素，

因此呈現的是連續光譜，其發光

行為是拉曼散射所造成的，因此

以藍紫光照射橄欖油會發出紅光，

其他油品則發白光，若以綠光雷

射檢驗，橄欖油會發紅光，其他

油品則發黃光。

0g 0.01g 0.1g 0.2g

0.3g 0.4g 0.5g 0.6g

0.7g 0.8g 0.9g 1.0g

低濃度 高濃度

綠光 藍紫光

手機光譜儀 手機光譜儀紅光濾色片 紅光濾色片自製儀器 自製儀器

拉曼散射
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